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Como iniciar sesion con su cuenta de Tl

Para usar el software emulador TI-SmartVi
necesitard iniciar sesién en su cuenta de TI

ew™ para las calculadoras MathPrint™,

1. Inicie el software emulador TI-SmartView™ para calculadoras MathPrint™.

Si esta es la primera vez que se inicia el software, se le pedira que acepte la
Licencia, la Politica de privacidad y los Términos de uso en linea.

®=

W TEXAS INSTRUMENTS

By using the application, you indicate your agreement with the
terms and conditions of the License, TI's Privacy Policy, and Tl's
Online Terms of Use.

DECLINE  ACCEPT

X

Haga clic en Accept.

2. Enelindicador de inicio de sesidn, haga clic en LAUNCH SIGN IN.

]

Please sign in to your account to continue.

"]

PURCHASE LICENSE LAUNCH SIGN IN

X

Nota: Si necesita comprar una licencia
LICENSE.

para un solo usuario, haga clic en PURCHASE

Esto abrira la pagina de inicio de sesidn de Texas Instruments en su navegador.
Complete el proceso de inicio de sesion con una cuenta de Google o con la
direccién de correo electrénico asociada con su cuenta de TI.

x
Please sign in to continue

i3 TEXAS INSTRUMENTS

SIGN IN

© scmmmicooa

Or sign in with email

1 Email (user name) ¢
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Después de validar su cuenta, un mensaje de éxito aparecera en el navegador y se
abrira el software.

Como ver la informacion de la licencia
Mientras esta conectado/a, puede ver los detalles de su licencia.

» Dirijase a Help > License Info.

= x
Account Info
email@domain.com

Subscription Expiration
2026-12-30

Session Expiration
6 Days 23 Hours 56 Minutes

Informacion de la cuenta: Direccion de correo electrénico del usuario actual.

Expiracion de la subscripcion: Fecha de vencimiento para la licencia del software
actual.

Expiracion de la sesion: Tiempo restante en la sesidn actual.

Mientras el software estd en uso, se conectard con el sistema de licenciamiento
cada 15 minutos. Si el usuario sale de linea en cualquier punto, el software se
ejecutara por siete dias a partir de la ultima vez en que estuvo conectado.

Como desconectarse de su cuenta

1. Dirijase a Help > Sign Out.

2. Haga clic en SIGN OUT.
El software se cerrard y una pestafia del navegador abrird la pagina de inicio de
sesion.

Cuando se cierra la sesidn se guarda el estado actual y libera la licencia de regreso
al grupo de lugares disponibles. Cerrar el software usando File > Exit o el boton

Cerrar no cierra automaticamente la sesion de un usuario y libera la licencia.
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Introduccion al software de emulador TI-SmartView™
para calculadoras MathPrint™

El software de emulador TI-SmartView™ para calculadoras MathPrint™ permite
mostrar el contenido de una calculadora gréfica a toda el aula.

Espacio de trabajo del emulador de calculadora

Permite:

e Seleccionar Emulador

{

% — Seleccionar el emulador con el que trabajar.
—  TI-30X Plus MathPrint™
— TI-30X Pro MathPrint™
— TI-30XS MultiView - TI-30XB MultiView™
- TI-34 MultiView™

e Ocultar/Mostrar la pantalla grande del emulador.

— Mostrar la vista de emulador completa con o sin un panel de
pantalla grande.

e Mostrar/ocultar la historia de pulsacién de las teclas

— Muestra imagenes de las teclas pulsadas para facilitar el
seguimiento del proceso por parte de los alumnos.

e Abrir una ventana de captura de pantalla independiente

— De igual modo que utiliza la opcién de captura de pantalla de Tl
Connect™ CE, capture y guarde como archivos de ordenador.

Consulte: Como usar el espacio de trabajo del emulador de calculadora como ayuda
para mejorar las presentaciones en su aula.
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Primer inicio: Cbmo seleccionar su tipo de emulador

La primera vez que inicia TI-SmartView™ para MathPrint™ en su ordenador, aparece un

cuadro de diadlogo de notificacion.

{17 Available Emulators
Select a default emulator:

TI-30X Plus MathPrint
TI-30X Pro MathPrint re using the
TI-30XS MultiView gt

Ti-34 MultiView

X

Elija su tipo de emulador en el menu
desplegable y seleccione OK.

El emulador seleccionado se mostrara en la
primera presentacion.

TI-SmartView™ para MathPrint™ siempre se inicia con el ultimo estado del software.
Una vez accedido al software, puede cambiar el emulador predeterminado.

Consulte: Como seleccionar un tipo de emulador.

El dltimo tipo de emulador a la vista se convierte en el predeterminado y el
ultimo tamanio de la ventana aparecera conforme a su ultima configuracion.

Consulte: Como cambiar el tamafio del panel de pantalla grande del emulador TI-

SmartView™
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Como usar el espacio de trabajo del emulador TI-
SmartView™ para calculadoras MathPrint™

El espacio de trabajo del emulador de calculadora TI-SmartView™ para MathPrint™
contiene herramientas que podra utilizar para introducir calculos .

5 TI-SmartView™ for MathPrint™ calculator

File Edit View ions Help

B- =mma

B os msrses T1-34 MultiView

S

()= ()
o
) ) o
o) o) (o) (o) 5
@II}EITI

Key Press History
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Partes del espacio de trabajo del emulador TI-SmartView™

o

File Edit View Actions Help

Barra de menus - utilice estos menus para llevar a cabo todas las funciones del
emulador, entre ellas:

. S . . Actions (Acciones): permite realizar
e File (Archivo): permite salir .
tareas, por ejemplo, capturar pantallas

e Edit (Edicidn): contiene
teclas de copia y cambio de
fuentes

e View (Ver): permite
cambiar las pantallas

Help (Ayuda): abre el sistema de ayuda y
muestra vinculos

Nota: La mayor parte de las acciones de estos menus se puede realizar con los
iconos de la barra de herramientas.

B Zaa @

Barra de herramientas: utilice los iconos de la barra de herramientas para:
e Seleccionar otro modelo de calculadora

e Cambiar alternativamente la presentacién de pantalla grande y mostrar u
ocultar el historial de pulsaciones de teclas

e Capturar la pantalla actual del emulador

@ Seleccionador de posicion del emulador y de la barra de herramientas

3
* Posicion del emulador a izquierda/derecha E—I - permite situar el
emulador en la parte izquierda o derecha de la pantalla de la calculadora
grafica, alternativamente. Es una opcion muy comoda cuando se utiliza un
proyector de pizarra interactiva.

e Barra de herramientas arriba/abajo EI - permite situar la barra de
herramientas en la parte superior o inferior de la pantalla, alternativamente

Es una opcién muy comoda cuando se utiliza un proyector de pizarra
interactiva.
Nota: Puede cambiar la posicidn y/o la distribucion visual de los elementos para
optimizar el acceso, especialmente cuando se utiliza una pizarra interactiva.

e Panel del emulador - utilice este panel para mostrar el emulador completo o
solamente el teclado del emulador.

@ Panel de pantalla grande/Panel del historial de pulsaciones de teclas: utilice
este panel para mostrar una versién grande de la pantalla de la calculadora y/o
el historial de pulsaciones de teclas.

Puede elegir entre las opciones de presentacion siguientes:

Coémo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™ 6



e Large Display Screen only (Solo e Key press history only (Solo historial

pantalla grande) de pulsaciones de teclas)
e Large Display Screen + Key Press
History (Pantalla grande + e Hide Large Display Screen (Ocultar el
Historial de pulsaciones de panel de pantalla grande)
teclas)

@ Cambiar tamafio de los paneles - haga clic y arrastre la barra vertical, situada
junto al borde de un panel, para cambiar su tamafio.

Como utilizar el teclado del emulador TI-SmartView™

El puntero del ratén actia de la misma manera a como lo hacen los dedos cuando
pulsan las teclas del ordenador.

Haga clic en las teclas del emulador TI-SmartView™ para MathPrint™ exactamente
igual que si pulsara las teclas de la calculadora cientifica.

Pulse y mantenga pulsada una tecla de flecha para desplazar el cursor de forma
continuada.

Cuando utilice una tecla de flecha para mover el cursor, manténgala pulsada; el cursor
se desplazara de forma ininterrumpida sin necesidad de tener que pulsar la tecla
varias veces. En el historial de pulsaciones de teclas, el icono para una tecla de flecha
de repeticion se indica con un simbolo de reloj situado en una de sus esquinas.

Al pulsar varias veces una tecla de flecha de una fila aparece una tecla con un
contador de repeticiones.

Cuando se pulsa varias veces una tecla de flecha en una fila, el historial de pulsaciones

de teclas muestra una tecla de flecha con un nimero DO que representa el nimero
de veces que se ha pulsado la tecla.

Como arrastrar y soltar pantallas de una aplicacion a otra

Puede utilizar el software TI-SmartView™ para calculadoras MathPrint™ para arrastrar
cualquier captura de pantalla a otra aplicacion en la que quiera soltarla y pegarla.

Las pantallas del emulador TI-SmartView™ para calculadoras MathPrint™ que puede
arrastrar y pegar incluyen las siguientes:

e la pantalla que aparece por encima del teclado en el panel del emulador
e Panel de pantalla grande

e Capturas de pantalla guardadas o no guardadas en espacio de trabajo de captura
de pantalla

7 Cémo usarel espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™



Como restablecer el emulador
Para restablecer el emulador:

1. Haga clic en Actions (Acciones).
2. Haga clic en Reset Emulator (Restablecer emulador).

3. Haga clic en Reset (Restablecer).

& :

Reset Emulator?

Resetting the emulator will overwrite all the

contents of the current emulator state.

Do you want to reset the emulator?

CANCEL RESET

.

Cuando se restablece el emulador:

e Se sobrescribe el estado actual del emulador

e Se limpia el historial de pulsaciones de teclas

Coémo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™ 8



Como guardar y cargar un emulador MathPrint™Estado

Cuando se guarda el estado del Emulador MathPrint™, se crea un archivo donde se
guardan los valores de configuracion del emulador junto con todos los cambios
realizados.

Por ejemplo, suponga que ha preparado una presentacion para una clase introduciendo
datos en el editor de datos y funciones en f(x) y g(x). Si ha guardado los cambios en el
archivo de estado del emulador, solo tendra que cargar el archivo con la presentacion.
A continuacion, y si desea crear otras presentaciones para otras clases, solo tendra que
crear tantos archivos de estado del emulador como necesite.

Nota: El archivo de estado del emulador no incluye el historial de pulsaciones de teclas,
las pantallas capturadas ni el tamafio del emulador. Recuerde que los archivos de
estado del emulador MathPrint™ pueden ser de gran tamario. Péngase en contacto con
su departamento de informatica si la capacidad de almacenamiento es un problema.

Para guardar el estado del emulador MathPrint™

La gestidn, almacenamiento y carga de archivos de estado del emulador solo esta
disponible para cada emulador MathPrint™. El archivo de estado del emulador TI-34
MultiView™ solo puede cargarse en el emulador TI-34 MultiView™.

Nota: El archivo de estado del emulador TI-30XS MultiView™ solo puede cargarse en el
emulador TI-30XS MultiView™.

1. Haga clic en Actions > Save Emulator State... (Acciones > Guardar estado del
emulador).

g for MathPrint™ ) - L= & |

File Edit View Actions Help

Save Emulator State...

Load Emulator State... I

Reset Emulator
Ij LI xC

(v l: BN

smg) (o) (o ) (] (e

A Tos |

) (o) (ot ) (o2 ) [
A
Exlwalralrales

(a5 08 ])[+
mﬁﬁﬁ

(=100

2. Enel cuadro de didlogo:
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a) Vaya a la carpeta en la que desee guardar el archivo de estado del emulador

MathPrint™.

b) Escriba un nombre de archivo. Utilice nombres descriptivos del estado del

emulador MathPrint™.

Nota: El archivo de estado del emulador MathPrint™ tiene un nombre de

archivo preconfigurado con la extensién *.s34 que indica el estado del

emulador de la calculadora TI-34 MultiView™ creado por el software de

emulador TI-SmartView™ MathPrint™.

c) Haga clic en Save (Guardar).

Coémo cargar el estado del emulador MathPrint™

Los archivos de estado del emulador MathPrint™ son especificos de cada modelo de
calculadora, de ahi que solo pueda cargarse el archivo de estado para el modelo de

calculadora que esté activa.

1. Haga clic en Actions > Load Emulator State (Acciones > Cargar estado del
emulador).

Capture Screen

Save Emulator State...

AP Toas
Load Emulator State...

Reset Emulator

[ [rmoce] k] @
R0 a O
Eojealealees
() (o) (oo ) (o2 ) [ £ ]
G 2O x ]
(A7 189 =
(e (4 (506 )|
I?H—H—H—l

2. En el cuadro de didlogo:

a) Desplacese hasta la carpeta que contenga el archivo de estado del emulador.

Nota: La pantalla solo contendra los archivos de listado del emulador
MathPrint™ correspondientes al modelo de calculadora activa.

b) Haga clic en el nombre del archivo de estado MathPrint™ para resaltarlo.

c) Haga clic en Open (Abrir).

Como usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™
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Como seleccionar una opcion de visualizacion

Puede personalizar el modo de visualizacion para ocultar o mostrar los paneles
opcionales, o cambiar el tipo de informacién que debe aparecer en cada uno. De forma
predeterminada, el software de emulador TI-SmartView™ para calculadoras
MathPrint™ muestra el espacio de trabajo del emulador de calculadora en pantalla
grande.

Como mostrar la pantalla de la calculadora

1. Hagaclicen 2. Vuelva a hacer clic en para
para mostrar el panel de pantalla grande.

ocultar el panel de
pantalla grande.

File Edit View Actions Help

B ma @

Cémo seleccionar un tipo de emulador

@V

Haga clic en la flecha abajo del icono para seleccionar un tipo de emulador.

TI-30X Plus MathPrint

-

1-30X Pro MathPrint !

=

-30X5 MultiView

VT34 Multiview H

Cada tipo de emulador se corresponde con un modelo de calculadora.
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Cémo cambiar la placa frontal de la calculadora
Para cambiar la placa frontal:

1. Haga clic en View (Ver).
2. Desplace el puntero hasta Calculator Faceplate (Placa frontal de calculadora).

3. Haga clic en el nombre de la placa frontal que prefiera.

Clara Oscura Esquema

& Texas nsrrovests T 1-34 MultiView

3 Teas hsmovests T 1-34 MultiView

9 Toxas bsroners  11-34 MultiView

1 2 TEG

I (e ]
G T~ T T ]
P

Coémo mostrar y ocultar el historial de pulsaciones de teclas

Haga clic en para mostrar u ocultar el historial de pulsaciones de teclas.
Haga clic en CLEAR (LIMPIAR) que aparece en el panel junto a Key Press History

(Historial de pulsaciones de teclas) para borrar el historial.

1 12 3]

Key Press History CLEAR

(5 )[=JL6]

€ Hagaclicaquiy @ Haga clicaqui Haga clic aqui para

arrastre para
cambiar el tamafio
del panel del
historial de
pulsaciones de
teclas.

después de
seleccionar teclas
para copiar la
fuente como
graficos.

borrar el
historial de
pulsaciones de
teclas.

Como usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™
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Cuando se pulsa la tecla para limpiar, se abre el cuadro de informacidn siguiente:

r ~
ED Key Press History [iE-J

Are you sure you want to clear the history?

CANCEL CLEAR

Como copiar el historial de pulsaciones de teclas en otra aplicacion

b

Puede copiar todo o una parte seleccionada del historial de pulsaciones de teclas en
otra aplicacion, por ejemplo, en un procesador de textos. También puede copiar los

graficos de tecla tal y como aparecen en el panel del historial, o las pulsaciones
de teclas como caracteres de texto fuente (5] (<] (6.

Nota: Los caracteres que se copian como caracteres de texto fuente utilizan la fuente
TI34EmuKeys. Solo se pegan las teclas de texto fuente principales. Las teclas de texto
fuente secundario no se pegan mediante la funcidn de copia como texto fuente de TI-
SmartView™. Puede insertar anualmente las funciones secundarias utilizando la fuente
instalada. Se trata de la fuente que se instala automaticamente en el ordenador al
instalar el software TI- SmartView™ para calculadoras MathPrint™.

Cémo copiar teclas como graficos o caracteres de fuente

1. Seleccione las teclas que desee copiar.
Para seleccionar teclas del panel del historial de pulsaciones, utilice uno de los
métodos siguientes:

Tecla Método
— Una tecla cualquiera: Haga clic en la tecla en cuestion.
— Varias teclas: Haga clic en una tecla.
Pulse y mantenga pulsada la tecla Ctrl
del teclado.

Haga clic en las demds teclas que
desee seleccionar.

— Varias teclas de una secuencia: Haga clic en una tecla.

Pulse y mantenga pulsada la tecla
Mayus del ordenador.

Pulse otra tecla.

Nota: Con este método seleccionard
las dos teclas en las que ha hecho clic
y todas las demas situadas entre
ambas.
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Tecla Método
— Todas las teclas: Haga clic en una tecla.
Haga clic con el botdn derecho del
ratén.
Haga clic en Select All (Seleccionar
todo).

Nota: Este es el aspecto de una tecla antes y después de seleccionarla.

Antes: Después:

2] (2]

2. Seleccione las teclas

3. Haga clic en Copy (Copia) (para copiar las teclas como graficos).
o

Haga clic en Copy As Font (Copiar como fuente) (para copiar las teclas como
caracteres de fuente principales) [5] [=] (6].

4. Cambie a otra aplicacion.

5. Pegue las teclas en la ubicacién apropiada.
Nota:

e Otra opcidn consiste en arrastrar las teclas seleccionadas como graficos hasta la
otra aplicacion.

e Puede cambiar el tamafio de los gréficos de las teclas después de pegarlos en la
nueva aplicacion.

e Enalgunas aplicaciones, los caracteres pegados pueden aparecer con la fuente de
la ubicacion de destino, por lo que pueden mostrar un aspecto distinto al de las
teclas de calculadora cientifica. Si fuera necesario, aplique a los caracteres la
fuente TI34EmuKeys. Consulte el archivo de ayuda de la aplicacidon de destino que
esté utilizando para obtener informacién sobre como aplicar la fuente a los
caracteres.

Cémo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™ 14



Como cambiar el tamano del panel de pantalla grande del
emulador TI-SmartView™

En el panel de pantalla grande, haga clic y arrastre el borde de un panel para cambiar
su tamano.

5 TI-SmartView™ for MathPrint™ calculatol

File Edit View Actions Help

H moaa @

&y Tens wsmasenrs 11-34 Multiview

[t ]

I-ﬂllj{_l-l_l
alerafealrlEs
R |l
[~ (710881~

dlear var

@E@EI_I

Key Press History ﬁ e

Nota: Todas estas acciones se realizan de izquierda a derecha, salvo el historial de
pulsaciones de teclas cuyo tamafio se aumenta o reduce hacia arriba o abajo.

Posiciones del emulador y de la barra de herramientas

=0 Posicion del emulador a izquierda/derecha: - permite situar el emulador en
la parte izquierda o derecha de la pantalla de la calculadora cientifica,
alternativamente. Es una opcién muy comoda cuando se utiliza un
proyector de pizarra interactiva.

= Barra de herramientas arriba/abajo: - permite situar la barra de
herramientas en la parte superior o inferior de la pantalla,
alternativamente Es una opciéon muy comoda cuando se utiliza un
proyector de pizarra interactiva.
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Always in Front (Siempre visible)

Seleccione esta opcion del menu View (Ver) para que las ventanas de emulador TI-
SmartView™ para calculadoras MathPrint™ se mantengan siempre delante de
cualquier otra ventana del software de ordenador que esté abierta, exactamente igual
que si tuviera la calculadora sobre la pila de papeles de la mesa de trabajo. Deje que la
ventana esté "siempre visible" en el lugar del escritorio del ordenador que le resulte
mas cémodo.

Cuando quiera que la ventana deje de estar "siempre visible", quite la marca de
seleccién de la opcidn del menu View (Ver). Esta caracteristica carece de icono en la
barra de herramientas, por lo que el Unico indicio de que estd activa es la marca de
seleccién en el menu.

Notas:

Tanto la ventana del espacio de trabajo del emulador TI-SmartView™ para
calculadoras MathPrint™ como la de captura de pantalla pueden estar "siempre
visibles" e intercambiar su lugar en primer plano dependiendo de su posicién.

No es aconsejable utilizar la opcion "Siempre visible" en modo de ventana completa,
ya que ocultard cualquier otra ventana de TI-SmartView™ para calculadoras
MathPrint™.

Cémo usar el espacio de trabajo del emulador TI-SmartView™ para calculadoras MathPrint™ 16



Como utilizar la herramienta de captura de pantalla

La herramienta de captura de pantalla del emulador TI-SmartView™ para MathPrint™
permite capturar la imagen actual que muestra la pantalla de la calculadora cientifica.

Para utilizar la captura de pantalla:

» Hagaclic en el icono de la barra de herramientas.

Esta accion abre esta ventana:

3 TI-SmontView Screen Capture lal@

File Edit View Actions

(O]
1

*Capture 1 @
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Partes del espacio de trabajo de captura de pantalla

o Capturar Haga clic en este icono para toma una captura de pantalla del
emulador.
Actions (Acciones) > Capture Screen (Capturar pantalla)

Nota: De forma predeterminada se afiade automaticamente
un borde a cada imagen que se captura; si desea eliminar el
borde, haga clic en View (Ver) > Hide Screen Capture Borders
(Ocultar bordes de captura de pantalla). (Si tiene varias
imagenes, esta accion borrara el borde de todas ellas).

Con la herramienta de captura de pantalla puede:

e capturar hasta 44 pantallas a la vez, (si desea capturar
mas imagenes, debera borrar algunas de la ventana de
captura de pantalla)

e almacenar automaticamente capturas de pantalla, que
permaneceran en la memoria hasta que se cierre la
ventana principal de TI-SmartView™ para calculadoras
MathPrint™.

Cuando se cierra la herramienta de captura de pantalla
aparece un mensaje solicitando que guarde las pantallas
capturadas. Puede iniciar una nueva sesion de captura de
pantallas durante una sesion de TI-SmartView™ para
calculadoras MathPrint™.

Guardar Haga clic en el icono para almacenar las capturas de pantalla
seleccionadas.
File (Archivo) > Save As (Guardar como)

Copy Haga clic en el icono para copiar las capturas de pantalla
seleccionadas en el portapapeles.
Edit (Edicién) > Copy (Copiar)

Borrar Haga clic en el icono para eliminar las capturas de pantalla
seleccionadas.
Edit (Edicion) > Delete (Borrar)

® © o o

Cambiar tamafio | Deslice el punto a lo largo de la barra para ajustar el tamaio
de vista previa de la captura de pantalla actual.

View (Ver) > Scale Screen Captures (Ajustar escala de
capturas de pantalla)

Nota: Las pantallas se guardan con el porcentaje de la vista.

@ Cambiar nombre | Cambie el nombre de una captura de pantalla resaltando el
titulo y escribiendo uno nuevo.

6 View Lugar para examinar las capturas de pantalla.

Como arrastrar y soltar pantallas de una aplicacion a otra

Puede utilizar el software TI-SmartView™ para calculadoras MathPrint™ para arrastrar
cualquier captura de pantalla a otra aplicacion en la que quiera soltarla y pegarla.

Cémo utilizar la herramienta de captura de pantalla 18



Las pantallas del emulador TI-SmartView™ para calculadoras MathPrint™ que puede
arrastrar y pegar incluyen las siguientes:

e La pantalla que aparece por encima del teclado en el panel del emulador
e Panel de pantalla grande

e Capturas de pantalla guardadas o no guardadas en espacio de trabajo de captura
de pantalla
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Mapeo de teclado del ordenador

Para pulsar una tecla puede utilizar el teclado del ordenador, en lugar de la tecla que
aparece en la imagen del teclado del emulador de TI-SmartView™.

Como utilizar el teclado del ordenador

Para pulsar una tecla del emulador utilizando el teclado del ordenador, busque en la
tabla siguiente la tecla de ordenador asociada con la tecla de emulador.

e TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™ métodos abreviados de teclado
e TI-30XS-30XB MultiView™ métodos abreviados de teclado

e TI-34 MultiView™ métodos abreviados de teclado

Mapeo de teclado del ordenador 20



TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™

Ejemplo: Para mostrar la pantalla de modo en el emulador, pulse [W] en el teclado del
ordenador como se indica en la tabla siguiente.

quit

TI-30X Pro MathPrint™ métodos abreviados de teclado:

TI-30X Plus MathPrint™ métodos abreviados de teclado:

2nd \M| delete | G) =
[Q] [W] | [Delete] [ <] [T]
[In log (math] [data] ® ®
[R] [T] [Y] (41 [—]
(e710° 53 (58] [table] [clear]
[U] [ [P] [A] | [Backspace]
1) £ 2] 2] =l
[D] [F] [G] [H] [11
(7 | 0
[J] [K] [(1 01 [*1
(] @ 8 9 =
[L] [7] [8] [9] [-1
55 (4] H| 8]
[Z] [4] [5] [6] [+]
sto-] [ 2 3] oz
[X] [1] [2] [31] [e]
[on] [0 ] [=] [enter]
[vl [0] [-1 [B] [Enter]
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*Nota:

En el teclado del ordenador MAC,

Pulse [Delete] para [delete].
Pulse [Backspace] para [delete].

2nd mode [delete © =
[aj [W] | [Delete] [<] "
% ['1
In log math [data] @ :D
[R] [T I [=]
@010 [Eg] B3 table]| clear
[U] 1 [P] [A] | [Backspace]
*

Mapeo de teclado del ordenador
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TI-30XS/30XB MultiView™

Ejemplo: Para mostrar la pantalla de modo en el emulador, pulse [W] en el teclado del
ordenador como se indica en la tabla siguiente.

quit

TI-30X45 MultiView™ keyboard shortcuts:

2nd 0] @
[Ql] [W] [Delete] [<1 (T
or or or
[CEril+ | [Ctri]+[ < ]
[Delete] e+ T
@ ®
[R] [T] [Yl 1 [>]
or or
[Ctri]+] —= 1
ctril[ 1
(in]
[U] [11 [P] [A] | [Backspace]
or
[Ctri]+
[Backspace]
MacE:
[Clear]
[sin] [cos] (=]
[D] [F] [G] [H] [/1
X7 0]
[J1 [K] | [Shiftl+[(] [ [Shift]+[)] [Shift]+[*]
E]] (-]
[L] [7] (2] 91 [-1
(4) (5] (6]
[Z] [4] [51 [6] [Shift]+[ +]
sto* [ 2] 3]
[X] [11 [2] [31] [C]
@ O =)
vl [o] [-1 [B] [Enter]
or
[Ctri]+[Enter]
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*Nota:

En el teclado del ordenador MAC,

Pulse [Delete] para [delete].
Pulse [Backspace] para [delete].

2nd mode [delete © =
[aj [W] | [Delete] [<] "
% ['1
In log math [data] @ :D
[R] [T I [=]
@010 [Eg] B3 table]| clear
[U] 1 [P] [A] | [Backspace]
*

Mapeo de teclado del ordenador
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TI-34 MultiView™

Ejemplo: Para mostrar la pantalla de modo en el emulador, pulse [W] en el teclado del
ordenador como se indica en la tabla siguiente.

quit

TI-34 MultiView™ keyboard shortcuts:

2nd ® ®

[al W] [Delete] [«1 p
or or [ 01

[Ctril+ | [Ctri]+[ <~ ] )
[Delete] et T
@ ®
[R] [T] [Y1] (1 [=>1]
or
G N
[ctrilf ]

raimp]
[ul [ [P] [A] | [Backspace]
or
[Ctril+
[Backspace]
MacE:
[Clear]

=]
[D1] [F] [G] [H] [/1
0]
[J1 [K]1 | [Shif]+[(] | [Shift]+[}] [Shift]+[*]
£l =
L1 [71 [8] [91 [-1
(6]
[Z1] [4] [51 [&] [+1

al 2] [E]

[X1] [1] [2] [3] [cl

[on] El =) enter
vl [0] [.] [B] [Enter]
or
[Ctri]+[Enter]
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*Nota:
En el teclado del ordenador MAC,

- Pulse [Delete] para [delete].
- Pulse [Backspace] para [delete].

2nd mode| [delete] © =
[aj [W] | [Delete] [<] "
* ['1
[In'leg math] [data] ] »
[R] [T] 1| 4 (1
el 10 [Eg] [38] table] clear|
[U] [ [P] [A] | [Backspace]
*
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Informacion general

Ayuda en linea

education.ti.com/eguide

Seleccione su pais para obtener mas informacién del producto.

Comuniquese con Asistencia de TI

education.ti.com/ti-cares

Seleccione su pais para obtener recursos técnicos y otro tipo de ayuda.

Informacion sobre el servicio y la garantia

education.ti.com/warranty

Seleccione su pais para obtener informacion acerca de la duracién de los términos de
la garantia o sobre el servicio para productos.

Garantia limitada. Esta garantia no afecta a sus derechos legales.
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